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Welcome to Photoshop Elements – a terri�c, affordable 
photo retouching application and graphics editor that just 
seems to get better and more feature-packed with every 
generation!

This is a program that seems to offer more wonderful 
surprises the deeper you dig into it. It provides not only 
the obvious tools for cleaning, stylizing and creating 
images, but also lots of not-so-obvious tools for managing 
your image �les, outputting a variety of print projects and 
even sharing your work online.

In this chapter, we’ll look at the various workspaces in 
Photoshop Elements – and then we’ll dig deeper, looking 
at the tools Adobe has added in its 2020 version to make 
the program even more fun to use.

Chapter 2
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Quick, Guided and Expert Editing
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What’s New in Version 2020?
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The Editor workspace
The Editor workspace in Photoshop Elements 2020 is actually several photo editing 
workspaces, each with its own set of tools and features.  Its three main workspaces can be 
accessed by clicking on the tabs at the top center of the interface.

• In the Quick Edit workspace, you’ll �nd a simpli�ed set of tools for cleaning up or 
enhancing your photos. We’ll show you how to use the tools in this workspace in 
Chapter 3.

• In the Guided Edit workspace, the program walks you, step by step, through the 
editing process. The Guided Edit tools can do some pretty advanced things too! Not 
only can Guided Edits walk you through simple clean-up of your photo, but they 
can also take you through some pretty high-level photo tricks, like creating a photo 
that seems to be standing on a re�ective surface, an image with a Tilt-Shift effect 
applied and a photo in which someone seems to be popping right out of the frame! 
We’ll show you how these cool edits work in Chapter 4.

• The Expert Edit workspace (illustrated above) includes a comprehensive photo 
editing and graphics creation Toolbox. This is likely where you’ll do most of your 
“serious” editing. It most closely resembles the workspace in the professional version 
of Photoshop. Needless to say, it’s the workspace most of this book is about.

Additionally, the Editor workspace shares a number of tools for creating fun photo pieces 
with the Elements Organizer under the Create and Share tabs in the upper right of the 
interface. We discuss these tools and how to use them in Chapter 16, Create Fun Pieces 
and Chapter 17, Share Your Photos and Videos.

The Welcome Screen

The Elements Hub
Whenever you launch Photoshop Elements, you’ll be greeted by the Elements 
Hub, a screen offering tips, tutorials and links to your Elements programs and 
projects.

A key feature of the Hub is a very intuitive help search tool. Type a brief 
description of what you’d like to do into the search box along the top of the 
screen and the Hub will suggest a list of related tutorials and helps (including 
some by yours truly!). Along the top of this panel you’ll also �nd thumbnails 
labeled Inspiration, What’s New and Try This, links to tutorials highlighting the 
program’s effects and tools.

Another key feature of the Elements Hub is something Adobe calls Auto 
Creations. Whenever your computer is up and running, the Organizer’s Auto 
Analyzer will be working in the background, looking for opportunities for 
Premiere Elements and, if it’s installed, Photoshop Elements to assemble your 
recently saved video �les and still photos into slideshows or movies or to create 
visual effects like Color Pop, Blur or Painterly Effects. (For more information on 
how the Auto Analyzer works, see page 222.) 

Your latest Auto Creation will appear in the lower left of the Elements Hub. To 
see the complete set, click the View All button. 

On the screen that opens, you’ll have the option of opening an Auto Creation 
in one of the Elements programs for further editing. 

To return to the Hub, click the Back button at the top of the Auto Creations 
browser panel.
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For instance, when your �les are displayed as �oating windows, you can copy images, 
portions of images and even entire layers from one image �le to another simply by 
dragging these elements from one open �le to another. 

As in the illustration above, there are two ways to switch between displaying your 
photos as a docked, tabbed set and displaying them as �oating windows:

• Set the Layout menu to All Floating. When you click on the Layout button and 
select All Floating, all of your photo �les will display as �oating windows.

• Undock a photo from the tabbed set by dragging on its tab. When you pull the 
photo �le by its tab from the others in a tabbed set, it becomes a �oating window. 

Floating windows, by the way, always �oat over tabbed photo �les. This means that, in 
order to get to the photos in your tabbed, docked set, you may have to either minimize 
any �oating windows or drag them out of the way.

To dock or re-dock a photo into a tabbed set, simply drag the �oating window by its 
docking header (the top of the window) to the top of the Editor workspace. When the 
photo �le becomes semi-transparent (as illustrated above) release your mouse button 
and the photo will dock to the tabbed set.

The Expert Editor Workspace

The Expert Edit Workspace

The Expert Edit workspace is modeled after the interface in the 
professional version of Photoshop.  

As illustrated at the top of the facing page, in Photoshop Elements, you 
have the option of displaying  your open photo and image �les as a single 
tabbed set, each photo �lling the Editor workspace panel and each open �le 
represented by a tab at the top of the workspace – or displaying your open 
photos as �oating windows, a stack of open �les that you can drag into any 
position around your computer desktop as you edit them. 

To �oat your windows, you must have Enable Floating Documents checked 
on the General screen under Edit/Preferences, as in the illustration above.

The option to display your �les in either mode – as well as a number of 
optional tabbed arrangements – is found under the Layout menu button.

The Layout menu button appears along the bottom of the 
interface, as seen in the illustration.

As many veteran Photoshop users know, there are advantages 
to displaying your photos as �oating windows rather than a tabbed set. 
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When you �rst open the program’s 
Expert edit workspace, this Panel Bin 
will be in Basic Workspace mode. In 
Basic Workspace mode, you can view 
the Layers, Effects, Filters, Styles or 
Graphics panels in this bin by clicking 
on the buttons in the lower right of the 
program’s interface. 

If you click on the arrow to the right 
of the More button, you will �nd the 
option to set the Panel Bin to Custom Workspace, which opens the Layers, Effects and 
Graphics panels (and their respective sub-panels) in the Panel Bin in a tabbed set, as 
illustrated below

You can click and drag on any tab in the Panel Bin to make its panel a separate, �oating 
panel. (It’s common for experienced Photoshop Elements users to make the Layers panel 
a �oating panel so that it is always available.)

Clicking directly on the More button will open an additional bundle of tabbed panels, 
including Info, Navigation, History, etc. These panels can likewise be accessed by clicking 
on the appropriate tab or, by dragging on the tab, can be made a separate, �oating panel.

We take a close up look at the Effects, Filters and Styles panels in Chapter 11, starting on 
page 159.

Guides, Rulers and the Toolbox

Guides and Rulers

Optionally, Photoshop Elements will display Guides over your image �les. 
These horizontal and vertical lines don’t show up on your �nal piece, of 
course. But they can be a great help for placing elements and text and 
ensuring that they are properly lined up.

The program can also display Rulers which, like Guides, can be very 
helpful in measuring and placing your imagery.

To display Rulers, select the option from the Photoshop Elements View 
menu. 

To create a new Guide, click and drag onto your photo from one of the 
Rulers running along the tops and sides of your image �les. (Drag from 
the Ruler along the top of your photo to create a horizontal guide or from 
the Ruler along the left of your photo to create a vertical guide.)

To toggle between displaying and hiding the guides on your image �les, 
press Ctrl+;  on a PC or +; on a Mac or select the option from the View menu.

The Toolbox

Along the left side of this workspace is the program’s Toolbox (as 
illustrated on the left). The tools in this panel serve a number of functions, 
from selecting areas in your image �le to creating graphics and text to 
patching and cloning areas of your images. As each tool is selected, that 
tool’s individual settings are displayed in the Tool Options Bin that runs 
along the bottom of the editing workspace.

We’ll spend considerable time getting to know the tools in the Toolbox 
and how to use their settings and options in Chapter 5, Get to Know the 
Photoshop Elements Toolbox. 

The Panel Bin

To the right of the editing workspace is a column known as the Panel Bin, 
which includes a number of tools and panels that vary, depending on 
whether you’re in Quick Edit, Guided Edit or Expert mode.
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What’s new in Photoshop Elements 2020?
Adobe continues to focus on simplifying many of the photo editing 
processes in version 2020. It include a couple of cool new semi-automatic 
tools as well as some new Guided Edits, tools that take you step-by-step 
through the process of enhancing your photos.

New Guided Edits

Adobe continues to build out its 
library of step-by-step helps in 
Photoshop Elements 2020, bringing 
the total number of photo editing 
walkthroughs to 55!

New to version 2020 are Guided 
Edits for restoring aged or damaged 
photos, for effectively removing 
people or objects from your photos 
and for painting a pattern of images 
across your pictures.

We discuss the entire Guided Edits 
library in detail in Chapter 4, Guided Edits.

What’s New in Photoshop Elements 2020?

The Photo Bin
Running along the bottom of the Editor workspace and sharing space 
with the Tool Options Bin is a small but powerful panel known as the 
Photo Bin. 

When the Photo Bin button is selected in the lower left of the 
program’s interface, all photos and image �les you have open in your 
Editor workspace will appear as thumbnails in this bin. 

To open a �le in your Photo Bin in the Editor workspace, double-click 
on its thumbnail in the Photo Bin.

Although this is the default and most common way to use the Photo 
Bin, it is certainly not its only function. The Photo Bin also interfaces 
with a number of other workspaces. 

To access and change the Photo Bin’s display options, click on the bin’s 
drop-down menu, which reads Show Open Files by default, as in the 
illustration above.

Show Open Files. Displays, as thumbnails, all of the image �les you 
currently have open in your Editor workspace.

Show Files Selected in the Organizer. If you have both Photoshop 
Elements and the Elements Organizer open, and you have �les 
selected in the Organizer’s Media Browser, selecting this option 
displays those �les in the Photo Bin. These photos or image �les 
can then be launched in the Editor workspace by double-clicking 
on them.

Organizer Albums. If you’ve created Albums in the Organizer (see 
Chapter 15, Manage Your Files with The Organizer), you can 
select the option to display the photos in a particular Album.
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Select Subject

Building on the semi-automatic Smart 
Selection technology introduced 
in version 2019, the latest version of 
Photoshop Elements now includes a 
fully automatic Select Subject tool 
that identi�es or person or object 
and in the foreground of your photo 
and automatically makes a selection 
based on its analysis. The tool works 
surprisingly well – and even when it 
doesn’t make a perfect selection, it 
provides you a pretty good starting 
point!

We show you how this tool works on page 101 of Chapter 6, Select and Isolate 
Areas in Your Photos.

Colorize Photo

Another nice, nearly automatic feature 
in version 2020 is the Colorize Photo 
tool, a tool which analyzes your black 
& white photo, identi�es objects in it 
and tints the areas accordingly. It works 
especially well at identifying faces and 
provides effective skins tones. 

It also includes �ne tuning tools for 
selecting and custom coloring areas in 
your pictures.

We show you how this tool works on 
page 126 of Chapter 8, Correct Color 
and Lighting.

Smooth Skin

Want to soften some of the age 
lines in a subject’s portrait? The 
new Smooth Skin tool identi�es 
faces in your pictures gently blurs 
the wrinkles – and it does so 
without affecting the other facial 
features or details in the picture.

It’s a very effective tool for 
touching up pictures, and we show 
you how it works on page 129 of Chapter 8, Correct Color and Lighting.

Organizer enhancements

Finally Adobe continues to 
improve performance in the 
Organizer – the media �le 
management tool bundled free 
with Premiere Elements and 
Photoshop Elements.

In addition to automatically 
generating Smart Tags for your 
videos as well as your photos, the 
Organizer also interfaces with the 
Elements Hub panel (see page 00), 
suggesting projects based on your 
media including  those using the 
programs’ color pop, blur effect, 
painterly effect and pattern brush tools.

We discuss the Organizer and its many �le management and project 
features in detail in Chapters 15, 16 and 17 of this book.

What’s New in Photoshop Elements 2020?

Need some Basic Training?

Need more help learning the basics of Photoshop Elements?

Check out my free tutorial series Basic Training for Photoshop Elements at Muvipix.com.

This simple, eight-part series will teach you the basics of photo resolution and show you 
how to adjust lighting and correct color in your photos, work with layers, add effects, scan 
your pictures and even share your photos and videos online. And, yes, it’s absolutely free! 

To see the series, just go to http://Muvipix.com and type “Basic Training for Photoshop 
Elements” in the product search box and then click the magnifying glass button. (We also 
offer Basic Training tutorials for other products, including Premiere Elements.)

And while you’re there, why not drop by the Community Forum and say hi! We’d love to 
have you become a part of our growing city. Hope to see you there!

If you’d like to see tutorials of some of the program’s latest features, check out our book 
page at Muvipix.com/pe2020.php.




